
NI SPEEDY-33
User Manual
Signal Processing Engineering Educational Device for Youth

NI SPEEDY-33 User Manual

August 2005
371577B-01



Support

Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters

11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 
Canada 800 433 3488, China 86 21 6555 7838, Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30, India 91 80 51190000, 
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Lebanon 961 0 1 33 28 28, Malaysia 1800 887710, Mexico 01 800 010 0793, Netherlands 31 0 348 433 466, 
New Zealand 0800 553 322, Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210, 
Russia 7 095 783 68 51, Singapore 1800 226 5886, Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197, 
Spain 34 91 640 0085, Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, Taiwan 886 02 2377 2222, 
Thailand 662 278 6777, United Kingdom 44 0 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment 
on National Instruments documentation, refer to the National Instruments Web site at ni.com/info and enter 
the info code feedback.

© 2005 National Instruments Corporation. All rights reserved.



 Important Information

Warranty
The NI SPEEDY-33 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no 
agency, partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.
Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.
All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.
Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.



Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

Platform Text in this font denotes a specific platform and indicates that the text 
following it applies only to that platform.
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1
NI SPEEDY-33 Overview

The NI SPEEDY-33 (Signal Processing Engineering Educational Device 
for Youth featuring the Texas Instruments VC33 DSP) is a self-contained, 
high-performance, programmable product for signal processing 
applications. It boasts an easy-to-use, fast Digital Signal Processor (DSP) 
along with a number of features important to many signal processing 
applications. The NI SPEEDY-33 onboard flash memory, together with an 
easy-to-learn, easy-to-use software programming tool, supports the quick 
creation of standalone DSP-based products.

Figure 1-1.  The NI SPEEDY-33
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Theory of Operation
The NI SPEEDY-33 is a low-cost, high-performance floating-point 
TMS320VC33-based DSP system connected to a standard PC through the 
USB port. This easy-to-use system supports a variety of DSP processing, 
including audio applications with two input/output analog channels 
sampled at 48 kHz, and other applications with onboard digital I/O for 
controlling motors/servos. The NI SPEEDY-33 features 34 K × 32 words 
of on-chip memory. The 512 K × 8 onboard flash memory allows for 
storage of both the program application (programmed with the LabVIEW 
DSP Module or VAB software), as well as data such as tables, sound 
waveforms, and so on. 

The NI SPEEDY-33 has eight lines of digital I/O, arranged as an eight-bit 
switch input port, and eight digital output LEDs. The digital I/O lines can 
be programmed with the LabVIEW DSP Module or VAB software. The 
eight inputs and eight outputs are also accessible through the simple 
expansion digital I/O connector. After the flash memory is programmed, 
the NI SPEEDY-33 can be unplugged from the PC and run in standalone 
mode.

Safety Information
The following section contains important safety information that you must 
follow when installing and using the module.

Do not operate the module in a manner not specified in this document. 
Misuse of the module can result in a hazard. You can compromise the safety 
protection built into the module if the module is damaged in any way. If the 
module is damaged, return it to National Instruments (NI) for repair.

Do not substitute parts or modify the module except as described in this 
document. Use the module only with the chassis, modules, accessories, and 
cables specified in the installation instructions. You must have all covers 
and filler panels installed during operation of the module.

Do not operate the module in an explosive atmosphere or where there may 
be flammable gases or fumes. If you must operate the module in such an 
environment, it must be in a suitably rated enclosure.

If you need to clean the module, use a soft, nonmetallic brush. Make sure 
that the module is completely dry and free from contaminants before 
returning it to service.
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Operate the module only at or below Pollution Degree 2. Pollution is 
foreign matter in a solid, liquid, or gaseous state that can reduce dielectric 
strength or surface resistivity. The following is a description of pollution 
degrees:

• Pollution Degree 1 means no pollution or only dry, nonconductive 
pollution occurs. The pollution has no influence.

• Pollution Degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused 
by condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs that becomes conductive due to 
condensation.

You must insulate signal connections for the maximum voltage for which 
the module is rated. Do not exceed the maximum ratings for the module. 
Do not install wiring while the module is live with electrical signals. Do not 
remove or add connector blocks when power is connected to the system. 
Avoid contact between your body and the connector block signal when hot 
swapping modules. Remove power from signal lines before connecting 
them to or disconnecting them from the module.

Operate the module at or below the measurement category1 marked on the 
hardware label. Measurement circuits are subjected to working voltages2 
and transient stresses (overvoltage) from the circuit to which they are 
connected during measurement or test. Measurement categories establish 
standard impulse withstand voltage levels that commonly occur in 
electrical distribution systems. The following is a description of 
measurement categories:

• Measurement Category I is for measurements performed on circuits 
not directly connected to the electrical distribution system referred to 
as MAINS3 voltage. This category is for measurements of voltages 
from specially protected secondary circuits. Such voltage 
measurements include signal levels, special equipment, limited-energy 
parts of equipment, circuits powered by regulated low-voltage sources, 
and electronics.

• Measurement Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 

1   Measurement categories, also referred to as installation categories, are defined in electrical safety standard IEC 61010-1.
2   Working voltage is the highest rms value of an AC or DC voltage that can occur across any particular insulation.
3   MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably rated measuring circuits may 

be connected to the MAINS for measuring purposes.
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refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (for example, 115 AC voltage for U.S. or 230 AC 
voltage for Europe). Examples of Measurement Category II are 
measurements performed on household appliances, portable tools, and 
similar modules.

• Measurement Category III is for measurements performed in the 
building installation at the distribution level. This category refers to 
measurements on hard-wired equipment such as equipment in fixed 
installations, distribution boards, and circuit breakers. Other examples 
are wiring, including cables, bus bars, junction boxes, switches, socket 
outlets in the fixed installation, and stationary motors with permanent 
connections to fixed installations.

• Measurement Category IV is for measurements performed at the 
primary electrical supply installation (<1,000 V). Examples include 
electricity meters and measurements on primary overcurrent 
protection devices and on ripple control units.

Installation
To install and set up the NI SPEEDY-33, refer to the NI SPEEDY-33 
Installation Guide. You can find this document on the NI SPEEDY-33 User 
Documentation CD or the National Instruments Web site at 
ni.com/manuals.

Software, Drivers, and Examples
The NI SPEEDY-33 is supported by the LabVIEW DSP Module and 
Visual Application Builder (VAB). A variety of example DSP applications 
are standard with both software packages.

LabVIEW DSP Module
Refer to the LabVIEW DSP Module Release Notes for information about 
installing the LabVIEW DSP Module software and NI SPEEDY-33 drivers 
onto your computer. You can find this document by selecting Start»
All Programs»National Instruments»LabVIEW 7.1 Embedded 
Edition»LabVIEW Manuals»DSP_Release_Notes.pdf.
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For a tutorial on using the LabVIEW DSP Module with the 
NI SPEEDY-33, refer to the Getting Started with the LabVIEW DSP 
Module document. You can find this document by selecting Start»
All Programs»National Instruments»LabVIEW 7.1 Embedded 
Edition»LabVIEW Manuals»DSP_Getting_Started.pdf.

Example applications for the NI SPEEDY-33 can be found in the 
NI Example Finder; in LabVIEW, select Help»Find Examples.

All NI user documentation is available on the National Instruments Web 
site at ni.com/manuals.

Visual Application Builder (VAB)
(Infinity Kit Users) Refer to the NI SPEEDY-33 Installation Guide for 
information about installing the VAB software and the NI SPEEDY-33 
drivers onto your computer. You can find this document on the 
NI SPEEDY-33 User Documentation CD.

For a tutorial on using VAB with the NI SPEEDY-33, refer to the VAB 
Starter’s Guide. The document can be found by selecting Start»
All Programs»VAB for INFINITY»VAB User Manual.

Software examples for the NI SPEEDY-33 can be found by clicking the 
Open Examples button, shown at left, on the VAB tool bar.

All NI user documentation is available on the National Instruments Web 
site at ni.com/manuals.
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2
NI SPEEDY-33 Functional 
Description and Interface

This chapter describes the NI SPEEDY-33 hardware functions and details 
of interfacing and configuring the device. Figure 2-1 shows the 
NI SPEEDY-33 layout.

Figure 2-1.  NI SPEEDY-33 Top View

1 Power Port (J10)
2 PC USB Port (J8)
3 Onboard Microphone (U2, U5)
4 DSP/On-Chip Memory (U6)
5 Flash Memory (U8)
6 Stereo A/D, D/A (U9)
7 Left Channel Audio Input Level Jumper (J1)
8 Right Channel Audio Input Level Jumper (J2)
9 Power LED (DS1)

10 Reset Button (SW1)
11 Audio Stereo Input Port (U11)
12 Audio Stereo Output Port (U14)
13 Switch Input Port (SW2)
14 Digital Output Port LEDs (DS2–DS9)
15 Flash Boot Jumper (J12)
16 Simple Expansion Digital I/O Connector (J11)
17 Standard Expansion Analog I/O Connector (J4, J6)
18 Flash Write Enable Jumper (J5)
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DSP
The digital signal processor on the NI SPEEDY-33 is a powerful 
floating-point, flexible, and easy-to-use processor designed by Texas 
Instruments.

The VC33 DSP is capable of high performance mathematical operations. 
It is a 32-bit, floating-point processor manufactured in 0.18 µm 
four-level-metal CMOS (TImeline) technology, and is part of the 
SM320C3x™ generation of DSPs from Texas Instruments.

The VC33 DSP internal busing and special digital signal processing 
instruction set have the speed and flexibility to execute up to 150 million 
floating-point operations per second (MFLOPS). The VC33 DSP optimizes 
speed by implementing functions in hardware that other processors 
implement through software or microcode. This hardware-intensive 
approach provides performance previously unavailable on a single chip.

Note Although this DSP is capable of 75 MIPS, 150 MFLOPS, the crystal driving the 
DSP on the NI SPEEDY-33 is slightly slower than what would be required to achieve this 
maximum speed, namely 14.7456 MHz as opposed to the maximum 15 MHz. This allows 
for specific desirable sample rates to be achieved for the A/D and D/A hardware described 
in the Stereo A/D, D/A section. Refer to the Appendix A, Specifications, for information 
about DSP speed.

The VC33 DSP can perform parallel multiply and ALU operations on 
integer or floating-point data in a single cycle. Each processor possesses a 
general-purpose register file, a program cache, dedicated ARAUs, internal 
dual-access memories, one DMA channel supporting concurrent I/O, and a 
short machine-cycle time, resulting in a high-performance, easy-to-use 
device.

Typical signal processing applications are enhanced by the large address 
space, multiprocessor interface, internally- and externally-generated wait 
states, one external interface port, two timers, one serial port, and a 
multiple-interrupt structure. The VC33 DSP supports a wide variety of 
system applications from host processor to dedicated coprocessor. 
High-level language support is easily implemented through a register-based 
architecture, large address space, powerful addressing modes, flexible 
instruction set, and well-supported floating-point arithmetic.
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Figure 2-2 shows the architectural details of the VC33 DSP.

Figure 2-2.  DSP Functional Block Diagram
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Memory Map
The DSP runs in microcomputer/bootloader mode on the NI SPEEDY-33. 
The memory map for the NI SPEEDY-33 is shown in Figure 2-3.

Figure 2-3.  NI SPEEDY-33 Memory Map

Reserved for Bootloader Operations
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FFFh
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3FFFFFh

Flash Memory (2048 KB in Space,r
Byte-Wide, Lowest Byte) 7 Wait States
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Memory
There are two types of available memory on the NI SPEEDY-33, on-chip 
memory and flash memory.

On-Chip Memory
The DSP uses on-chip memory for algorithms because of its fast speed. 
There are 136 KB of on-chip RAM that the DSP can access with zero wait 
states. This memory is used for both program and data space.

Flash Memory
Flash memory is included to allow the NI SPEEDY-33 to be programmed 
and run in standalone mode, without connection to a PC. This is essential 
for producing actual products or self-standing prototypes. Refer to the 
Flash Boot Jumper section for information on configuring the jumper to 
enable flash memory boot up for standalone mode.

The flash memory is byte-wide and organized as 512 K × 8, with the DSP 
mapping it to a 512 K × 32 (2048 KB) area, only able to read the lowest 
byte (upper 24 bits are not read by or written to the DSP). Refer to the Flash 
Write Enable Jumper section for information on jumper configurations for 
enabling or disabling flash memory write protection.

Ports

PC USB Port
The PC USB port (J8) connects the NI SPEEDY-33 (target) to a PC (host) 
with a standard USB cable. The NI SPEEDY-33 functions as a full-speed 
USB device when connected to the PC host. The PC USB port is a Type B 
USB port (peripheral USB port) and conforms to USB Specification 1.1. 
When the NI SPEEDY-33 is connected to the PC, the USB port supplies 
power to the device, eliminating the need for the power port (J10), 
described in the Power Port section. When power is supplied to the device, 
the power LED lights.

Caution Do not connect the power source to the power port while the NI SPEEDY-33 
device is connected to the PC.
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Power Port

Caution Do not connect the power source to the power port while the NI SPEEDY-33 
device is connected to the PC. 

The power port (J10) can supply the NI SPEEDY-33 with external power 
when operating the device in standalone mode, without being connected to 
the PC through USB. When power is supplied to the device, the power LED 
lights.

The input voltage must be 9 VDC, at 500 mA, with the outside contact 
being ground and inner contact being positive VDC. An appropriate 
2.5 mm jack can be used in conjunction with a 9 V battery (pack) to 
optionally supply power for battery-powered applications. Refer to 
Appendix A, Specifications, for complete power supply specifications.

Audio Stereo Input Port
Audio input can be connected to the audio stereo input port (U11).

Caution Ensure that line level audio signals are not connected to the audio input when the 
NI SPEEDY-33 is configured for microphone level. It is possible to damage the audio input 
circuitry by overdriving the input.

If an external microphone is used, it should be capable of operating with a 
standard stereo jack; not all microphones will work in this fashion. Many 
PC microphones will not work because they require a DC voltage to be 
driven on one of the inputs. Traditional mono microphones generally work 
fine.

It is important to ensure that the audio input level jumpers (J1, J2) setting 
is configured appropriately for microphone level or line level, depending 
upon the audio source connected to this port. Refer to the Audio Input Level 
Jumpers section for more information.

Note The onboard microphones are disconnected by mechanical disconnect when an 
audio source is connected to the audio stereo input port.

Audio Stereo Output Port
The audio stereo output port (U14) can be connected to a set of stereo 
amplified speakers. Typical amplified speakers used for PC sound should 
provide good output. You also can plug external headsets to this port, 
although there is no hardware control over the output gain, or signal level.
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Onboard Microphones
Two onboard microphones (U2 and U5) can be used in applications 
requiring audio input or involving audio signal phase difference 
measurements. When the microphones are used, the input gain level of 
each microphone should be set to the microphone level setting described in 
the Audio Input Level Jumpers section.

Caution Ensure that line level audio signals are not connected to the audio input when the 
NI SPEEDY-33 is configured for microphone level. It is possible to damage the audio input 
circuitry by overdriving the input.

The onboard microphones are directly connected to the audio input 
conditioning circuitry, unless an external microphone is connected at the 
stereo input port (U11), as described in the Audio Input Level Jumpers 
section. If an external microphone is connected, the onboard microphones 
are disconnected from the input circuitry by mechanical disconnect.

Digital Output Port LEDs
Eight memory-mapped LEDs are located on the NI SPEEDY-33 for 
general-purpose output. The LEDs are enabled by writing a 1 to the 
appropriate bit of the LED port. The LED output state is echoed on pins on 
the simple expansion digital I/O connector (J11), described in the Simple 
Expansion Digital I/O Connector section.

Switch Input Port
There are eight memory-mapped general-purpose switch inputs on the 
NI SPEEDY-33. These switch inputs are accessed by the DSP through 
reading the appropriate bit of the switch input port. The switch inputs are 
connected in parallel to pins on the simple expansion digital I/O connector 
(J11). All switches should be in the OFF (open) position when connecting 
the expansion digital I/O connector, as described in the Simple Expansion 
Digital I/O Connector section.
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Stereo A/D, D/A
The 16-bit stereo audio CODEC included on the NI SPEEDY-33 allows for 
up to 48 kHz dual-channel sampling on the input signal. Software 
components are included in the LabVIEW DSP Module and VAB to allow 
8 kHz, 18 kHz, 24 kHz, 36 kHz, and 48 kHz sample rates to be used in 
applications.

Refer to the Audio Input Level Jumpers section for information on jumper 
settings that configure the amount of gain, from the onboard or external 
microphones, applied to the input audio signals.

I/O Connectors

Simple Expansion Digital I/O Connector
The simple 20-pin expansion header (J11) allows for easy interface to 
external hardware. The header includes power, ground, eight digital inputs, 
and eight digital outputs under DSP control.

The eight input bits are co-mapped to the switch input port. The eight 
output bits are co-mapped to the digital output port LEDs, described in the 
Digital Output Port LEDs section.

If the input bits on this connector will be used by an external piece of 
hardware, the switch input port, described in the Switch Input Port section, 
must have all the switches set in the OFF (open) position (all switches up, 
away from device). An ON (closed) switch position (switch down, towards 
the device) will effectively short that specific input bit to ground. Switch 1 
correlates to IN1 on the connector, switch 2 correlates to IN2, and so on. 
The connector pinout is shown in Figure 2-4.
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Figure 2-4.  Simple Expansion Digital I/O Connector (J11)

The digital I/O signals are 3.3 V, but the inputs are 5 V tolerant. Although 
not required, pin 20 (ResetLow) can be driven low to reset the DSP; it is 
pulled high by the NI SPEEDY-33.

Standard Expansion Analog I/O Connectors
A set of two connectors, J4 and J6, make up the standard expansion analog 
I/O connectors, that can be used for optional daughter modules. The 
daughter modules can be used for applications requiring different A/D 
and/or D/A functionality than that provided by the standard 16-bit stereo 
CODEC normally found on the NI SPEEDY-33. 

Refer to the Connecting Accessories to the NI SPEEDY-33 document for 
information on NI and third-party daughter modules for use with the 
NI SPEEDY-33. This document is available on ni.com/manuals.

Jumpers

Audio Input Level Jumpers
The audio input level jumpers (J1, J2) control the amount of gain applied 
to the input audio signals.

The microphone level setting has the highest gain for the onboard 
microphones (U2, U5), the line level setting has less gain and is appropriate 
for the line level audio interface (for example, CD players, MP3 players, 
and so on).

19 20
17 18
15 16
13 14
11 12
9 10
7 8
5 6
3 4
1 2 3 V (Out)

OUT1 (Out)
OUT2 (Out)
OUT3 (Out)
OUT4 (Out)
OUT5 (Out)
OUT6 (Out)
OUT7 (Out)
OUT8 (Out)
ResetLow (In)

5 V (Out)
IN1 (In)
IN2 (In)
IN3 (In)
IN4 (In)
IN5 (In)
IN6 (In)
IN7 (In)
IN8 (In)

GND
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These settings will affect the gain of the external audio source, and should 
be left in the line level setting if an external microphone or audio source is 
used at audio stereo input port (U10), described in the Stereo A/D, D/A 
section. Table 2-1 shows the possible audio input level settings.

Caution Ensure that line level audio signals are not connected to the audio input when the 
NI SPEEDY-33 is configured in the microphone level setting. It is possible to damage the 
audio input circuitry by overdriving the input.

Flash Boot Jumper
The flash boot jumper (J12) controls whether the DSP will attempt to boot 
from the flash memory. The default setting is for the DSP to boot from flash 
memory, described in the Flash Memory section. You must set the 
NI SPEEDY-33 to the enable flash boot setting to run the device in 
standalone mode.

If the NI SPEEDY-33 will only be used with the USB connection to PC, the 
flash boot can be disabled, though it is not recommended. Table 2-2 shows 
the possible flash boot settings.

Table 2-1.  Audio Input Level Jumpers (J1, J2) Settings

Jumper Microphone Level
Line Level 

(Default Setting)

Audio Input Level, 
Left Channel (J1)

Position 1 Position 3

Audio Input Level, 
Right Channel (J2)

Position 1 Position 3

123 123

123 123
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Flash Write Enable Jumper
The flash write enable jumper (J5) controls whether the DSP can write to 
the flash memory, described in the Flash Memory section. This 
configuration setting is useful for write protecting the DSP algorithm for 
production purposes. When the flash write is disabled, the DSP is unable to 
modify the contents, even if it attempts to do so. Table 2-3 shows the 
possible flash write enable settings.

Reset Button
The reset button (SW1) is a small push button on the NI SPEEDY-33 that 
manually resets the DSP. The DSP will need to be reset in the event of a 
software or hardware freeze.

Table 2-2.  Flash Boot Jumper (J12) Settings

Jumper
Enable Flash Boot 
(Default Setting) Disable Flash Boot

Flash Boot Position 1 Position 3

Table 2-3.  Flash Write Enable Jumper (J5) Settings

Jumper
Enable Flash Write 

(Default Setting) Disable Flash Write

Flash Write Enable Position 1 Position 3

1

2

3

1

2

3

123 123
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A
Specifications

Specifications listed below are typical at 25 °C unless otherwise noted.

Analog I/O
Input ....................................................... Stereo 48 kHz 16 bit A/D

Output..................................................... Stereo 48 kHz 16 bit D/A

Supported sampling rates ....................... 8 kHz, 18 kHz, 24 kHz, 36 kHz, 
48 kHz

Maximum working voltage for analog inputs
(signal + common mode) ....................... 600 mV

Maximum working voltage for analog outputs
(signal + common mode) ....................... 1.41 V

Input impedance

Left to AI GND............................... 30 kΩ
Right to AI GND............................. 30 kΩ

Digital I/O
Input ....................................................... 8 bit switch,

pins <IN1..IN8> on J11

Output..................................................... 8 bit LEDs,
pins <OUT1..OUT8> on J11

Maximum working voltage.................... TTL 5 V signal

Memory
On-chip RAM ........................................ 34 K × 32

Flash ....................................................... 512 K × 8
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DSP
DSP.........................................................TMS320VC33

• High-performance floating-point digital signal processor (DSP)

– 150 million floating-point operations per second (MFLOPS)

– 75 million instructions per second (MIPS)

• 34 K × 32 bit (1.1-Mbit) on-chip words of dual-access static 
random-access memory (SRAM) configured in 2 × 6 K 
plus 2 × 1 K blocks to improve internal performance

• 32-bit high-performance CPU

• 16/32-bit integer and 32/40-bit floating-point operations

• Boot-program loader

• 32-Bit instruction word, 24-Bit Addresses

• Fabricated using the 0.18-µm (leff-effective gate length) TImeline™ 
technology by Texas Instruments (TI)

• On-chip memory-mapped peripherals

• Direct Memory Access (DMA)

• Coprocessor for concurrent I/O and CPU operation

• Parallel arithmetic/logic unit (ALU) and multiplier execution in a 
single cycle

• Supports standalone operation

Bus Interface
USB ........................................................Full speed 1.1

Power Requirements
Input voltage

External power supply
powered operation ...........................9 VDC at 500 mA at power port 

with appropriate safety and EMC 
Certification marks, which are 
acceptable in the country in which 
the product is to be installed

USB powered operation ..................USB bus power

Device maximum current .......................0.233 A
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Physical
Dimensions............................................. 8.89 cm × 12.7 cm × 1.91 cm

(3.5 in. × 5 in. × .75 in.).

Weight .................................................... 2.1 g (61 oz)

USB connector ....................................... Type B USB port, conforms to 
USB Specification 1.1

Connector ............................................... Standard mini stereo jack

I/O connectors

J1, J2, J5, J12 .................................. 0.10 in. × 0.10 in. × 0.23 in. 
in 1 × 3 rows

J4..................................................... 0.10 in. × 0.10 in. × 0.23 in. 
in 2 × 5 rows

J6, J11 ............................................. 0.10 in. × 0.10 in. × 0.23 in. 
in 2 × 10 rows

Environmental
Operating temperature............................ 0 to 55 °C

Storage temperature ............................... –20 to 70 °C

Humidity ................................................ 10 to 90% RH, noncondensing

Maximum altitude .................................. 2,000 m

Pollution Degree 
(indoor use only) .................................... 2

Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, and 
laboratory use:

• IEC 61010-1, EN 61010-1

• UL 61010-1

• CAN/CSA-C22.2 No. 61010-1
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Note For UL and other safety certifications, refer to the product label, or visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m; 

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 
Table 1

CE, C-Tick, and FCC Part 15 (Class A) Compliant

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE Marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility
Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 
regulatory compliance information. To obtain the DoC for this product, visit 
ni.com/certification, search by model number or product line, and click the 
appropriate link in the Certification column.
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B
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at ni.com 
for technical support and professional services:

• Support—Online technical support resources at ni.com/support 
include the following:

– Self-Help Resources—For answers and solutions, visit the 
award-winning National Instruments Web site for software drivers 
and updates, a searchable KnowledgeBase, product manuals, 
step-by-step troubleshooting wizards, thousands of example 
programs, tutorials, application notes, instrument drivers, and 
so on.

– Free Technical Support—All registered users receive free Basic 
Service, which includes access to hundreds of Application 
Engineers worldwide in the NI Developer Exchange at 
ni.com/exchange. National Instruments Application Engineers 
make sure every question receives an answer.

For information about other technical support options in your 
area, visit ni.com/services or contact your local office at 
ni.com/contact. 

• Training and Certification—Visit ni.com/training for 
self-paced training, eLearning virtual classrooms, interactive CDs, 
and Certification program information. You also can register for 
instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, National Instruments 
Alliance Partner members can help. To learn more, call your local 
NI office or visit ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of 
compliance with the Council of the European Communities using 
the manufacturer’s declaration of conformity. This system affords 
the user protection for electronic compatibility (EMC) and product 
safety. You can obtain the DoC for your product by visiting 
ni.com/certification.
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If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Numbers/Symbols

% percent

+ positive of, or plus

– negative of, or minus

± plus or minus

< less than

> greater than

≤ less than or equal to

≥ greater than or equal to

/ per

° degree

Ω ohm

+5 V (signal) +5 VDC source signal
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A

A amperes

A/D Analog-to-Digital

AC Alternating Current

ADC Analog-to-Digital Converter—An electronic device, often an integrated 
circuit, that converts an analog voltage to a digital number.

ADC resolution the resolution of the ADC measured in bits. A 16-bit ADC has a higher 
resolution, and thus a higher degree of accuracy, than a 12-bit ADC.

ADE Application development environment such as LabVIEW, 
LabWindows™/CVI™, BridgeVIEW, Visual Basic, C, and C++.

AI Analog Input

analog A signal whose amplitude can have a continuous range of values.

AO Analog Output

B

b bit—one binary digit, either 0 or 1

B byte—Eight related bits of data, an eight-bit binary number. Also used to 
denote the amount of memory required to store one byte of data.

bandwidth The range of frequencies present in a signal, or the range of frequencies to 
which a measuring device can respond.

bit One binary digit, either 0 or 1.

boot The way you start or restart your computer or device. The procedure that is 
run immediately following hardware reset or power-up.

buffer Temporary storage for acquired or generated data (software).

bus The group of conductors that interconnect individual circuitry in a 
computer. Typically, a bus is the expansion interface to which I/O or other 
devices are connected. Examples of PC buses are the ISA bus and PCI bus.
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BW bandwidth

byte eight related bits

C

C Celsius

CE European emissions control standard

CFR Code of Federal Regulations

CH channel

channel Pin or wire lead to which you apply or from which you read the analog or 
digital signal. Analog signals can be single-ended or differential. For digital 
signals, you group channels to form ports. Ports usually consist of either 
four or eight digital channels.

CMRR Common-Mode Rejection Ratio—A measure of the ability of a differential 
amplifier to reject interference from a common-mode signal, usually 
expressed in decibels (dB).

CMV Common-Mode Voltage

CODEC coder-decoder—An electronic device that converts analog signals, such as 
video and voice signals, into digital form, and then compresses them to 
conserve bandwidth on a transmission path. The NI SPEEDY-33 CODEC 
also converts digital signals into analog form.

connector A fixture (either male or female) attached to a cable or chassis for quickly 
making and breaking one or more circuits. 
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D

D/A Digital-to-Analog

DAQ data acquisition—(1) Collecting and measuring electrical signals from 
sensors, transducers, and test probes or fixtures and processing the 
measurement data using a computer.
(2) Collecting and measuring the same kinds of electrical signals with A/D 
and/or DIO boards plugged into a computer, and possibly generating 
control signals with D/A and/or DIO boards in the same computer.

DAQ device A data acquisition device. Examples are DIO, E Series MIO, and Lab/1200 
plug-in data acquisition devices.

dB decibel—The unit for expressing a logarithmic measure of the ratio of 
two signal levels: dB = 20log10 V1/V2, for signals in volts.

DC Direct Current

DC coupled Allowing the transmission of both AC and DC signals.

default setting A default parameter value recorded in the driver. In many cases, the default 
input of a control is a certain value (often 0) that means use the current 
default setting.

device A plug-in data acquisition product, card, or pad that can contain multiple 
channels and conversion devices. Plug-in products, PCMCIA cards, and 
devices such as the DAQPad-1200, which connects to your computer 
parallel port, are all examples of DAQ devices. SCXI modules are distinct 
from devices, with the exception of the SCXI-1200, which is a hybrid.

digital An electronic technology where a signal only has two states: off and on, 
most often called zero and one. In contrast, analog refers to a signal that can 
have a continuous range of values. 

digital I/O The capability of an instrument to generate and acquire digital signals.

Static digital I/O refers to signals where the values are set and held, or 
rarely change. Dynamic digital I/O refers to digital systems where the 
signals are continuously changing, often at multi-MHz clock rates. The 
NI SPEEDY-33 is a static digital I/O device.

digital port See port.
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DIO Digital Input/Output

DMA Direct Memory Access—A method by which data is transferred to/from 
computer memory from/to a device or memory on the bus while the 
processor does something else. DMA is the fastest method of transferring 
data to/from computer memory.

DR Data Receive

drivers/driver software Software that controls a specific hardware device such as a DAQ device.

DSP (1) Digital Signal Processing
(2) Digital Signal Processor—a specialized microprocessor designed 
specifically for digital signal processing, generally in real-time. Digital 
signal processors can also be used to perform general-purpose 
computation, though they are not optimized for this function.

dual-access memory Memory that can be sequentially accessed by more than one controller or 
processor but not simultaneously accessed. Also known as shared memory.

E

EEPROM Electrically Erasable Programmable Read-Only Memory—ROM that can 
be erased with an electrical signal and reprogrammed. 

EMC electromagnetic compliance

EMI electromagnetic interference

event The condition or state of an analog or digital signal.

expansion connector A connector on the device for connecting additional signals to the DSP.

F

F (1) Fahrenheit—A temperature measurement scale. 
(2) farad—A measurement unit of capacitance.

FIFO First-In First-Out memory buffer—The first data stored is the first data sent 
to the acceptor. FIFOs are often used on DAQ devices to temporarily store 
incoming or outgoing data until that data can be retrieved or output.
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flash A form of rewritable memory chip that, unlike a Random Access Memory 
chip, holds content without maintaining a power supply.

frequency The number of alternating signals that occur per unit time.

ft feet

H

h hour

Hz hertz—Cycles per second of a periodic signal; the unit of measure for 
frequency.

I

I/O Input/Output—The transfer of data to/from a computer system involving 
communications channels, operator interface devices, and/or data 
acquisition and control interfaces.

in. inch or inches

instrument driver A set of high-level software functions that controls a specific GPIB, VXI, 
or RS232 programmable instrument or a specific plug-in DAQ device. 
Instrument drivers are available in several forms, ranging from a function 
callable language to a virtual instrument (VI) in LabVIEW. You can 
download instrument drivers from the Instrument Driver Network at 
ni.com/idnet.

J

jack See port.

jumper A small rectangular device used to connect two adjacent posts on a circuit 
board. Jumpers are used on some SCXI modules and terminal blocks to 
either select certain parameters or enable/disable circuit functionality.
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K

k kilo—The standard metric prefix for 1,000, or 103, used with units of 
measure such as volts, hertz, and meters.

K (1) kelvin
(2) kilo—The prefix for 1,024, or 210, used with B in quantifying data or 
computer memory.

kbytes/s A unit for data transfer that means 1,000 or 103 bytes/s.

kS 1,000 samples

L

LabVIEW A graphical programming language.

LabVIEW DSP 
Module

A fully-featured graphical DSP design tool based on LabVIEW.

LED Light-Emitting Diode

library A file containing compiled object modules, each comprised of one of more 
functions, that can be linked to other object modules that make use of these 
functions.

M

m meters

M (1) Mega, the standard metric prefix for 1 million or 106, when used with 
units of measure such as volts and hertz.
(2) mega, the prefix for 1,048,576, or 220, when used with B to quantify data 
or computer memory.

max maximum

MB megabytes of memory

Mbytes/s A unit for data transfer that means 1 million or 106 bytes/s.
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memory (1) The high-speed electronic storage components of a computer or 
instrument product. Typically, access times of electronic memories are less 
than 100 ns, while hard disk drives have access times in the range of 10 ms. 
The most common form of electronic memory is Random Access Memory 
(RAM). 
(2) The chips in a computer that can store data when the computer is 
powered on. Different from storage devices, such as disks or tapes. 

memory map Maps physical resources such as RAM and EPROM to particular CPU 
addresses. A software memory map maps particular code segments to 
particular CPU addresses.

memory buffer See buffer. 

MFLOPS Million floating-point operations per second.

min (1) minutes
(2) minimum

N

NC Normally Closed, or Not Connected

NP No Pullup

O

onboard channels Channels provided by the plug-in data acquisition device.

OUT output signal

P

p pull up (v.),
pull-up (adj.)

PC Personal Computer

peripherals Devices that can be connected to your computer or the NI SPEEDY-33. 
Common peripheral devices are USB DAQ cards, printers, and keyboards.
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port (1) A communications connection on a computer or a remote controller. 
(2) A digital port, consisting of four or eight lines of digital input and/or 
output.

R

ROM Read-Only Memory

S

s seconds

S Samples

S/s Samples per second—Used to express the rate at which a DAQ device 
samples an analog signal.

sample An instantaneous measurement of a signal, normally using an 
analog-to-digital convertor in a DAQ device.

SPEEDY-33 Signal Processing Engineering Educational Device for Youth— A 
self-contained, high-performance, programmable product for signal 
processing applications.

switch (n.) A device for routing signals between two points.

U

USB Universal Serial Bus—A 480 Mbit/s serial bus with up to 12 Mbps 
bandwidth for connecting computers to keyboards, printers, and other 
peripheral devices. USB 2.0 retains compatibility with the original USB 
specification.
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V

V volts

VAB Visual Application Builder—A component-based DSP design software.

VI Virtual Instrument—(1) A combination of hardware and/or software 
elements, typically used with a PC, that has the functionality of a classic 
stand-alone instrument.
(2) A LabVIEW software module (VI), which consists of a front panel user 
interface and a block diagram program.

Visual Application 
Builder

See VAB.

volatile memory Memory that loses its contents when the power is turned off.

W

word The standard number of bits that a processor or memory manipulates at 
one time. Microprocessors typically use 8-, 16-, or 32-bit words.
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A
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left channel (table), 2-10
microphone level (caution), 2-10
right channel (table), 2-10
settings (table), 2-10

audio stereo input port, 2-6
and onboard microphones (note), 2-6
using microphone level (caution), 2-6

audio stereo output port, 2-6

B
block diagram, DSP, 2-3

C
CODEC, 2-8
connector

I/O, 2-8
simple expansion digital I/O, 2-8
simple expansion digital I/O pinout 

(figure), 2-9
standard expansion analog I/O, 2-9
USB, 2-5

D
Declaration of Conformity (NI resources), B-1
diagnostic tools (NI resources), B-1
diagram, 2-1
digital

output port LEDs, 2-7
simple expansion I/O connector, 2-8

simple expansion I/O connector pinout 
(figure), 2-9

switch input port, 2-7
digital signal processor. See DSP
disabling flash boot (table), 2-11
documentation, NI resources, B-1
drivers

LabVIEW DSP Module, 1-4
NI resources, B-1
Visual Application Builder, 1-5

drivers (NI resources), B-1
DS1 (power LED), 2-5
DS2–DS9 (digital output port LEDs), 2-7
DSP, 2-2

block diagram, 2-3
on-chip memory, 2-5
resetting, 2-11

E
enabling flash boot (table), 2-11
examples (NI resources), B-1
expansion I/O connector

analog, 2-9
digital, 2-8

external
headsets, using, 2-6
microphones, using, 2-6

F
flash boot jumper, 2-10

settings (table), 2-11
flash memory, 2-5

disabling flash write, 2-11
enabling flash write, 2-11
enabling flash write setting (table), 2-11
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flash boot jumper, 2-10
flash write enable jumper, 2-11
write protection, 2-11

flash write enable jumper, 2-11
settings (table), 2-11

functional description, 2-1

H
hardware installation, 1-4
help, technical support, B-1

I
I/O connector

simple expansion digital, 2-8
standard expansion analog, 2-9

installation, 1-4
safety information, 1-2

instrument drivers (NI resources), B-1
interface, 2-1

J
J1 (left channel audio input level jumper), 2-9
J2 (right channel audio input 

level jumper), 2-9
J4 (standard expansion analog 

I/O connector), 2-9
J5 (flash write enable jumper), 2-11
J6 (standard expansion analog

I/O connector), 2-9
J8 (PC USB port), 2-5
J10 (power port), 2-6
J11 (simple expansion digital 

I/O connector), 2-8
J12 (flash boot jumper), 2-10
jumper

audio input level, 2-9
flash boot, 2-10
flash write enable, 2-11

K
KnowledgeBase, B-1

L
LabVIEW DSP Module, 1-4
LED

digital output port, 2-7
power, 2-5

M
memory 

flash, 2-5
on-chip, 2-5

memory map 
(figure), 2-4

microphone
external, 2-6
onboard, 2-7

mode, standalone, 1-2

N
National Instruments support 

and services, B-1
NI SPEEDY-33

diagram, 2-1
digital output port LEDs, 2-7
drivers, 1-4
DSP, 2-2
functional description, 2-1
I/O connectors, 2-8
installation, 1-4
interface, 2-1
jumpers, 2-9
memory, 2-5
memory map, 2-4
onboard microphones, 2-7
overview, 1-1
ports, 2-5
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reset button, 2-11
software, 1-4
software examples, 1-4
stereo A/D, D/A, 2-8
switch input port, 2-7
theory of operation, 1-2

NI support and services, B-1

O
onboard microphone, 2-7

configuring microphone 
level (caution), 2-7

on-chip memory, 2-5
overview, 1-1

P
PC USB port, 2-5

connecting with power 
source (caution), 2-5

pinout, simple expansion digital 
I/O connector (figure), 2-9

port
audio stereo input, 2-6
audio stereo output, 2-6
digital output LEDs, 2-7
PC USB, 2-5
power, 2-6
switch input, 2-7

power
LED, 2-5
port, 2-6

programming examples (NI resources), B-1

R
reset button, 2-11
resetting the DSP, 2-11

S
safety information, 1-2
simple expansion digital I/O connector, 2-8

pinout (figure), 2-9
software

examples, 1-4
LabVIEW DSP Module, 1-4
NI resources, B-1
Visual Application Builder, 1-5

speakers, using, 2-6
standalone mode, 1-2, 2-6
standard expansion analog I/O connectors, 2-9
stereo

A/D, D/A, 2-8
amplified speakers, using, 2-6
input port, 2-6
output port, 2-6

support, technical, B-1
SW1 (reset button), 2-11
SW2 (switch input port), 2-7
switch input port, 2-7

T
technical support, B-1
theory of operation, 1-2
training and certification (NI resources), B-1
troubleshooting (NI resources), B-1

U
U2 (onboard microphone), 2-7
U5 (onboard microphone), 2-7
U6

DSP, 2-2
on-chip memory, 2-5

U8 (flash memory), 2-5
U9 (stereo A/D, D/A), 2-8
U11 (audio stereo input port), 2-6
U14 (audio stereo output port), 2-6
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USB port, 2-5
connecting with power source 

(caution), 2-5

V
VAB. See Visual Application Builder
Visual Application Builder, 1-5

W
Web resources, B-1
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